Stream Habitat Measurement Techniques
U.S. Fish and Wildlife Service, National Conservation Training Center 

[bookmark: _GoBack]Water Body Identification, Regional Setting, and Drainage Catchment Attributes

This packet is your pre-course assignment.  We recommend that you save this document as a .pdf to facilitate toggling between this file and the website links. 
Please print this packet and bring the completed assignment with you to class on the first day. We will go over the answers in class and answer any specific questions you may have.
In addition to in-stream habitat measurements, it is always important to characterize the sampling site within its larger context.  This characterization includes water body identification (especially location), regional description (e.g., physiographic province, ecoregion), and drainage catchment size and geomorphic properties. We will make extensive use of two on-line viewers; the USGS “The National Map Viewer” and EPA’s “Enviromapper for Water”.  
For this pre-course assignment, we will take you through the process to characterize a sampling site using a specific stream location in Maryland.  After you have become familiar with the various tools, then you will do the actual characterization of the field site we will be visiting during the week of the class.  It is very important that you finish this assignment prior to your arrival at NCTC as there will be no time to complete it after the class has begun.
Water Body Identification
Detailed identification is important for:
· Organization of sample sites in data bases;
· Identification by other data users; and
· Relocation on maps (e.g., GIS) or in the field.
Three forms of documentation:
· Descriptive attributes as name, stream classification (e.g., Rosgen), state designated use, impairment status (Clean Water Act section 303(d)), ownership, accessibility, etc.;
· Location coding with a unique number assignment (e.g., HUCs, EPA reach codes); and
· Position identification (latitude, longitude, UTMs, elevation) 

Position identification (‘exact’ location) :
· Latitude, longitude, and Universal Transverse Mercator (UTM) coordinates define the location of a point on earth in two-dimensional space (elevation can be used as well to add the 3rd dimension) 
· Latitude, longitude, UTM coordinates, and elevation can be obtained easily from map viewers on the internet or USGS topographic maps.
· River mile or river kilometer still used, particularly on larger rivers, but less common overall
Latitude and Longitude-
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Practical Exercise- (fill out the data form in Appendix 2 as you go through the exercises, the answers are located in Appendix 4 at rear of this document):
We will now work with the location of the stream sample site.  The site is on an unnamed tributary of Little Antietam Creek.
The position is:  Latitude 39.6611˚ N and Longitude -77.5463˚ W
These readings are in “decimal degrees” (the coordinates are expressed as decimal fractions).

· Convert latitude and longitude in decimal degrees to degrees, minutes, and seconds.
There are simple formulas to do this task, however it’s even easier to use an internet-based converter.  Go to:
http://www.fcc.gov/mb/audio/bickel/DDDMMSS-decimal.html
Use the lower box to plug in latitude decimal degrees and then longitude decimal degrees of the sample site to convert to degrees, minutes, and seconds.  Enter only numbers and the negative sign if appropriate, do not enter units (as degrees, minutes).

Record the Answer on your Data Sheet, Appendix 2


*Note that the converter also will convert degrees, minutes, and seconds into decimal degrees.


· Convert site position from latitude and longitude to Universal Transverse Mercator (UTM) coordinates.  See Appendix 1: Universal Transverse Mercator Geographic Coordinate System for an overview of the UTM coordinate system.

Go to UTM converter:  http://www.dmap.co.uk/ll2tm.htm 
Enter Degrees, Minutes, and Seconds for the stream site location (numbers only, no units). Do not enter negative signs for lat/long coordinates west of Greenwich or south of the equator. Specify W or S instead. Then choose grid area UTM (WGS84 datum) and select “Calculate” for determining the central meridian longitude. Finally, click the convert button to derive the Easting, Northing, and Grid Reference. The number(s) preceding the letters of the Grid Reference is the UTM zone.
Your answer will be the coordinates for the sample site defined as:

Zone#   Easting (m)   Northing (m)

Record the Answer on your Data Sheet, Appendix 2


*Note:  A good way to visualize lat-long and UTM is using Google Earth.  



If you have Google Earth downloaded on your computer:

Open Google Earth > click on “View” menu on upper left > select “grid” > click on “Tools” > “Options” > select the “3D View” tab > select the “Decimal Degrees” radial button in middle left of the box. Click “OK”. You’ll see the latitude-longitude grid appear on the globe.  You can scroll in and out for a close-up or father-out perspective.

Now, to get the UTM grid, go back to “Tools” > “Options” > select the “Universal Transverse Mercator” radial button.  Click “OK”. You’ll see the UTM grid appear, with zone numbers laterally and zone alphabetical designations vertically.


Now, find the sample site on a map.  Go to the USGS National Map Viewer at:

http://nationalmap.gov/viewers.html

Click on “Click here to go to The National Map Viewer and Download Platform!” link.  (If you want additional assistance, click on the “Help” link in the upper right-hand corner).

Screenshot of the National Map Viewer

[image: ]

All tools you will be using are located under the “Toolbox” menu bar at the top of the map.  
[image: ]



[image: ]Under the “Standard” tab of the menu bar,
	Map Navigation icon ( [image: ]): must be selected when zooming, scrolling, and 	moving around map.
	Identify icon ( [image: ] ): used for obtaining stream or watershed information such as 	hydrologic unit codes (HUCs)
	Find Coordinates icon ( [image: ] ): is a location identifier
	Reverse Geocode icon ([image: ])
	Clear Graphics icon ( [image: ] ): important; same as “Clear Map” link on top right of 	viewer; must use this tool to remove map information from a previous query 	before continuing; otherwise, the program will operate slowly.
	Reset Zoom & Zoom icons ([image: ])
	Spot Elevation icon ( [image: ] ): used to determine 1) elevation of any map point, and  	2) stream reach codes.
	We will not be using the “Download Data”, “Download by Bounding Box”, and 	“Bounding Box from Coordinates” icons

Under the “Advanced” tab (will only mention two icons),
Measure Distance icon ( [image: ] ): use to measure linear distance between two points.
	Measure Area icon ( [image: ] ): used to measure area, specifically catchment 	drainage area in our case.

Note: make sure that your selected icon is labeled as the “Active Tool:_______” located in the menu bar.
			[image: ]

Go to the search box at the top, enter the latitude and longitude coordinates in decimal degrees (separated by a space and do not include the degree symbol or letter designations) for the unnamed tributary of Little Antietam Creek. Click “Search”.

Latitude 39.6611˚ N and Longitude -77.5463˚ W

[image: ]Point “A” is our site.  Click on “Zoom To”


 
If you zoom out (by using the zoom bar on the upper left of the map), note that two locations appear: one in the northern hemisphere and one in the southern hemisphere.  This is because the map-viewer will not allow N, S, E, or W designations.  We are interested in the northern hemisphere site.  Go to the panel on the left and click “Zoom To” under point “A”.  The map and “Selection” tab opens:


[image: ]Zoom bar
Overlays tab


The study site location, marked by a circle denoted as Point “A”, is just upstream of Warner’s Gap Hollow dam reservoir.

Using the zoom bar on the left of the map, zoom in and out (change scale).


· What is the county and state of the sampling location?

	To find this information, you must select layers in the “Overlays” tab on the far left.  (If the “Overlays” box did not open when you entered the lat/long coordinates, click on the “Overlays” tab at the left top of viewer).  Overlays provide the data layers to the map, such as Topo maps, elevation contours, and hydrography information.

· In the “Overlays” box, make sure that the “Content” sub-tab is open (blue highlighted).

· Select “Government Unit Boundaries” by checking the box (checked boxes are the map’s active layers); county and state boundaries will appear. 

Record the Answer on your Data Sheet, Appendix 2


· Find the USGS topographic map name that contains the sample site

· Select the “US Topo Availability” layer by checking the adjacent box; once the layer is loaded, expand the “US Topo Availability” by clicking on the [image: ] icon to the left of the box; then deselect “Index of Available Maps”.  The red diagonal lines will then disappear.

The USGS topographic maps are outlined in green and the names appear in green.  Zoom out to the necessary extent (scale 1:144,448 works).

Record the Answer on your Data Sheet, Appendix 2



· Find the sampling site elevation

· Zoom in to better locate cursor on site; under the “Standard” tab above map, select the map navigation icon to reposition the sample site if necessary
· Still under the “Standard” tab, click on “Spot Elevation” icon to make it the active tool
· Now, move arrow cursor to sampling site location on the unnamed tributary.  Click to determine elevation.  

Record the Answer on your Data Sheet, Appendix 2


Trouble-shooting note: if the viewer does not respond in a fairly short period of time, you may have to close-out previously opened layers or even restart.  If you have problems loading any layer, then change scale and re-try.



· Find water body codes (HUC, reach codes)


Hydrologic Unit Codes (HUC)

The USGS organizes watersheds or drainage basins of the United States into a hydrologic system that divides and subdivides the country into successively smaller watersheds. These levels of subdivision, used for organization of hydrologic data, are called "hydrologic units."  Numerical codes, called "hydrologic unit codes (HUC)," are associated with these units. The hydrologic unit codes describe the relation among the hydrologic units to represent the way smaller watersheds drain areas that together form larger watersheds.


Agencies use HUCs for:

· managing natural resource data;
· presenting stream survey and monitoring results;
· storing and retrieving water quality data;
· mapping land cover
	Regions are the largest watersheds shown. Regions contain either the drainage areas of a major river, such as the Missouri region, or the combined drainage areas of several rivers, such as the Texas-Gulf region.  Regions are identified by 2 digit codes.
[image: Huc_region-edit]Regions of the United States









Subregions divide the regions and they include the area drained by a river system, a section of a river and its tributaries in that reach, a closed basin(s), or a group of streams forming a coastal drainage area.  Subregions are identified by 4 digit codes.
Basins (or Accounting units) subdivide many of the subregions. They are used by the USGS for managing national water data.  Basins are identified by 6 digit codes.
Subbasins (or Cataloging units) are larger than 700 square miles in area. A subbasin is a geographic area representing part or all of a surface drainage basin, a combination of drainage basins, or a distinct hydrologic feature.  Subbasins are sometimes called “watersheds” as in EPA’s Surf Your Watershed (example: Conococheague-Opequon Watershed).  Subbasins are identified by 8 digit codes.
Watersheds are identified by 10 digit codes.
Subwatersheds are identified by 12 digit codes.
Hydrologic unit codes are from 2 – 12 digits.  A HUC8 (subbasin or cataloging unit) is 8 digits.  For example, Nyes Run in the Susquehanna River drainage in Pennsylvania is a part of the subwatershed identified by the code:
020503050905
Region =		02
Subregion =		0205
Basin =		020503		(Accounting unit)
Subbasin =		02050305		(Cataloging unit, EPA watershed)
Watershed =		0205030509
Subwatershed =	020503050905


EPA Reach Codes

The National Hydrography Dataset (NHD) is a digital (computerized) collection of points, lines and polygons that represent surfacewater features, such as streams, lakes and swamps. Simply put, the NHD can be thought of as 'the blue lines on a map'. The NHD addressing system employs a unique, standard identifier, known as the reach code, for each segment of water across the country. Reach codes provide the foundation or common 'language' supporting integrated surfacewater analysis between EPA Water Programs, states, tribes and other users.  Reach codes contain 14 digits.

A reach is the portion of a stream between two points of confluence. A confluence is the location where two or more streams flow together. In the NHD addressing system, a reach code identifies each reach in the same manner that a street name identifies each street. Reach codes are comprised of the 8-digit EPA watershed code followed a 6-digit arbitrarily-assigned sequence number.


Using the reach coding scheme, we can see that watershed 01080105 contains the five reaches:
	[image: These reach codes act like street names.]
	[image: http://www.epa.gov/epafiles/images/epafiles_misc_space.gif]
	- 01080105000001
- 01080105000002
- 01080105000003
- 01080105000004
- 01080105000005

[image: http://www.epa.gov/waters/images/watershed_georef_legend.gif]



Position along a reach is determined relative to the reach extent. The downstream end of a reach is labeled as 0% and the upstream end as 100%. If a monitoring site, for instance, lies halfway along a reach, its position is 50%. 

Start “Hydrography (NHD) data layer:

· Under “Overlays”>”Content”> select the “Hydrography (NHD) data layer.
· Deselect the layers “Government Unit Boundaries” and “US Topo Availability” under the “Overlays” tab by clicking in the box next to the layer title.

First thing you’ll notice is more complete stream delineation by blue flow lines and stream names.  Reaches are delineated by triangles. The triangles point in a downstream direction.  (The reach containing the sampling site is outlined in green).

· Go back to “Standard Tab” in the menu bar.  Make “Identify” icon the active tool (click on the icon).  When you select “Identify”, a drop-down list notes the layers that will be identified.
· Click down somewhere on the reach containing the sampling site, hold and move cursor to form a rectangle within the reach (reach ends denoted by triangles); let go and the NHD information will load.

The map is now filled with green hash lines.  In the left window, are listed HUCs from 2 digit (hydrologic unit: Regions) to 12 digit (hydrologic unit: Subwatersheds).  You can click on the “Zoom To” under each HUC division to see the geographic depiction of each hydrologic unit.  The issue is that HUC 4 - 12 digit divisions are colored alike (green, we’ll deal with this later).  Regional boundaries are purple.

Now, identify and better delineate the hydrologic units (HU), from Regional to Subwatershed level for the sampling site.

· Make sure that “Map Navigation” is active tool.
· Under “Selection” tab of the left window, click on “Zoom To” under the Region 02; you’ll see the entire region.
· Region 02 is bordered by purple lines and the HUC 4s begin with “02”
· Similarly, the other HUs are identified with a letter and HUC in the left-hand window; you will see them located on the map by letter at the regional scale.
· Note: if you click on the map, you may change the hydrologic units selected; if that happens, click on the “Clear” link in the upper right-hand corner and search again for the sampling site and redo the “identify hydrologic units” procedure above.
· In left-hand window, click on “Zoom To” under the Subwatershed (12-digit HU); change Subwatershed color from green to your choice by clicking on the down arrow on the Subwatersheds bar above; a palatte of colors appear to choose from.
· To determine the name and calculate area of the subwatershed, click on the Subwatershed 12-digit HUC in the left-hand window. A box will appear that lists the HUC number and name; at the bottom of the box, click on “More” and then click on “Get Area” in the drop-down menu. (The “Get Area” function may be temporarily unavailable).
· Continue to successively larger hydrologic units by clicking on “Zoom To” under each, from Watershed to Region, and change the color of each as you go.

Note: For this Subregion, there is only one Basin, therefore the Subregion and Basin are the same geographic area and the Basin is not listed.


· List HUCs and their names and areas:

To locate the name of each HUC2 – HUC8 in the Region, go to: 

http://water.usgs.gov/GIS/regions.html

(Hint: the site is in HUC 02 Mid-Atlantic Region)

Note: areas are only listed for HUC4, HUC6, and HUC8.

You can practice determining areas by tracing the boundary of a HUC unit (try Subwatersheds) with the Measure Area tool (under the “Advanced” tab; make it the Active tool).

· “Zoom To” so the entire HUC division, as the Subwatershed, is visible.  Follow the Subwatershed boundaries.  To change direction, click once; to finish, click twice.  Once you double-click, the area measured is filled in and area measurements appear.

Note: if you incorrectly delineate the area, then you must clear graphics and identify hydrography information again.  (A bit inconvenient).

Record the Answers in the chart provided on your Data Sheet, Appendix 2


· Determine the EPA Reach Code for the sample site (also stream name, class, and length)

Return to the USGS National Map Viewer at:

http://nationalmap.gov/viewers.html


· Clear map (note that NHD layer is still present or active)
· Center sample site (search on lat/long coordinates and then “Zoom To” site)
· Go to the “Standard” menu bar (on top) and make “Identify” the active tool
· In the “Identify Layers” tab on the left, deselect all layers except “Flowline”
· Next, with “Identify” active, click, hold, and draw a rectangle on the reach containing the sample site
· After loading, the selected reach will be outlined in green, delineating the reach between triangles (which themselves usually are at confluences)
· In the left window, under Selection > Results tab, click on the stream name (“Null” denotes an unnamed reach); there should be only one result “A”
· A box will appear on the map, pointing to the stream reach that will provide the 14-digit reach code, steam length, and the stream name.
· You can draw a rectangle on any reach visible on the map viewer to determine the stream name (GNIS ID) and reach code 

Record the Reach Code & Reach Length on your Data Sheet, Appendix 2

· Click on other upstream and downstream tributaries to see additional reaches and reach codes; if the reach is named, the GNIS ID will be listed as a link; click on the GNIS ID and you will be taken to a new window having additional information on that reach








Google Earth can be a good communication tool to share sample site location data.  For example, open Google Earth and enter the lat-long coordinates for our sample site (39.6611 -77.5463) in the search box upper left.  You should get this:
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[image: ]
Click on the “Add Placemark” [image: ].  A “New Placemark” box and a yellow location placemark on the map will appear.  In the box, the coordinates will be automatically filled.  If, under Tools>Options, the Decimal Degrees radial button is selected, then the coordinates listed will be Latitude and Longitude.  However, if the Universal Transverse Mercator radial button is selected, coordinates will be in UTMs.  Next, type in “Warner Hollow branch sample site 1” in the Name box.  You can enter a description as “Just upstream of Edgemont Reservoir” in the Description tab.  Click “OK”.









Placemark indicating the sampling site.

[image: ]
To save the location on your hard drive, in the upper left corner, click on File>Save>Save Place As…

A “Save As” box will appear.  You can change the name of the file.  The extension is “.kmz”.  This file can be double-clicked which will open Google Earth and take the view to the sampling site.  This .kmz file can be emailed for others to view your sampling location.


· Determine “Impairment Status”


We will leave The National Map Viewer and use another Viewer entitled MyWATERS Mapper, an EPA application. Go to:

http://www.epa.gov/waters/enviromapper/

· Click link at bottom to launch the mapper;
· Enter the following sampling site latitude and longitude coordinates (numbers and negative sign only) into the “Go To” bar on left.  Make sure the selection immediately below is “Address or Location”.  Click on “Go”.

Latitude 39.6611˚ N and Longitude -77.5463˚ W

· Sample site should be centered in view and briefly show as a red dot with coordinates.  The site indicator will disappear.  You can click on the “Go” button and the indicator will reappear but will not remain visible.
· On the right, click on the “Other EPA Water Data” menu bar.  Check “Rivers and Streams (NHD)”, “Watershed Boundaries (WBD)”, and “Impaired Waters” (see following image) on the drop down menu.
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· The NHD streams will be either blue or red lined.  At this scale, HUC12 subwatershed boundaries will be visible (purple colored).  To see larger hydrologic units, use the zoom bar on the left to zoom out.  Finally impaired streams will be outlined in red.  To see what category of impairment, click on the “Water Impairments” bar and select “Pathogens”.  Click the “Show Impairments” bar.  Streams impaired by pathogens will be bolded red.  Follow the same process for “Nutrients” and finally “Sediment”.

· By double-clicking on or near the sample site, a “Features of this Location” box will appear.  There are several sub-boxes that contain information on the stream reach (“Flowlines”) and the Subwatershed (HUC12).   Under the “Flowlines” bar at the top, if the reach is named, the reach name will appear next to “Name”. Other information includes waterbody type, reachcode, HUC12, and reach length.  

NOTE: The NHD Reachcodes and lengths may not be correct yet so get those values from the USGS National Map.
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· To locate STORET Water Monitoring stations near the sampling site, click on the “Other EPA Water Data” bar, and check the box next to “STORET Water Monitoring stations”.  Station locations will appear as a blue triangle.  Go to the “Water Monitoring Data” bar, click on “Get Sampling Results for Specific Locations” (nothing apparently happens), and then draw a rectangle/square around a water quality monitoring station.  These actions will bring up information about that station and data download links to STORET (storage and retrieval).

· Back to our sample site on an un-named tributary of Little Antietam Creek, is this reach designated as an “impaired water”?  Remember that when the “Impaired Waters” box is checked, impaired reaches will highlight in red.

· Please explore this mapper for additional information.  Once satisfied, you may close the mapper.

Record any impairments on your Data Sheet, Appendix 2


Regional Setting

Regional setting influences the physical structure (geomorphology) and biological structure of a stream reach.  As such, regional setting attributes can be used to stratify streams into categories for sampling design or analysis.

· Regions represent broad patterns of climate and geology and influence many properties of aquatic habitats (hydrology, substrates, morphology, etc.).
· A region is recognized as having aquatic habitats that are more similar to each other than they are to habitats in other regions.
· When working with large spatial scales, recognizing groupings of similar habitats helps a biologist establish benchmarks for habitat potential and lowers variability in data.

Regional classification systems often are hierarchical.  

· Regional management must consider multiple spatial scales to accommodate aquatic systems.
· Series of levels organized so that finer classified regions nest within the next larger class.
· These classification systems provide a stratification framework that can reduce data variability thereby improving power of projects to detect trends or differences.


Example of a hierarchical structure in spatial frameworks (Bailey’s Ecoregion System)

[image: ]


Regional Settings include such classification systems as
· Physiographic provinces
· Hydrogeomorphic regions
· Ecoregions

Physiographic Provinces
Based on: TOPOGRAPHY (mountains, plains, plateaus, uplands) and GEOLOGY (rock type and geologic structure and history)

· Hierarchical, 8 major divisions, 25 natural subdivisions (provinces)
Differ in climate, vegetation, surficial deposits and soils, water supply, mineral resources
· Boundaries between provinces are often sharp
· Used to identify fish distributions

An Example of Physiographic Provinces Contained Within a State
[image: ]












The Physiographic Province system may be subdivided into successively smaller units:
Major Division > Province > Section > Region > District > Area
(Note: different terminology is sometimes used; e.g., “subprovince” used for “Section”)

For example, a stream site in Maryland might be classified as within the
Applalachian Highlands Division
	Blue Ridge Province
		Northern Blue Ridge Section
			Middletown Valley Region
				Lower Middletown Valley District
					Catoctin Creek Gorge Area








Practical Exercises-for the following practical exercises please refer to the resource maps located at:  

http://nctc.fws.gov/courses/csp/csp3200/resources/index.html


· Find the physiographic province, section, and region of the sample site on the un-named tributary of Little Antietam Creek.  Use the Physiographic Map of Maryland (note that the sample site location is indicated by an arrow). You may save as a .pdf for better viewing or just use the zoom function at the bottom right corner.
 
	Record the Answer on your Data Sheet, Appendix 2

*Note:  For a narrative description of the physiographic province characteristics, see James P. Reger, J.P. and ET. Cleaves. 2008. An Expanatory Text for the Physiographic Map of Maryland. Open-File Report 08-03-01 Map of Maryland Description.  You’ll see an overview of the physiographic region classification system starting on page one and a brief description of the Blue Ridge Province on page 5.


Hydrogeomorphic Regions

· Used for stratifying ground-water discharge patterns and wetland functions
· Based on lithology (rock type) and physiography based on geologic formations
Open Hydrogeomorphic Regions which maps the hydrogeomorphic regions of the Chesapeake Bay watershed.

· What hydrogeomorphic region is the sample site located in?

	Record the Answer on your Data Sheet, Appendix 2


Ecoregions

Relatively uniform areas defined by several key geographic variables (physical and biotic)

· such as, geology, landform, soils, vegetation, climate, wildlife, land use
· hierarchical classifications (broad scale to fine scale)

Ecoregions are used to:

· identify the natural characteristics and potential of aquatic systems;
· determine regional boundaries to set benchmark biotic potential and to measure and evaluate aquatic system integrity against the appropriate benchmark;
· establish water quality standards;
· stratify sampling sites;
· extrapolate to regional information from site-specific studies


2 commonly used classification systems:

Bailey’s	(provides a broad synthesis of ecosystem geography of the US)

Omernik’s	(provides a classification for regionalizing water resource management and for distinguishing regional patterns of WQ in ecosystems as a result of land use)


For this class, we will use Omernik’s Ecoregion classification system.

· A classification for regionalizing water resource management
· Used to distinguish regional patterns of water quality due to land uses
· Found to correspond well to spatial patterns of water quality and fish distribution

Hierarchical:

Level I (15 ecoregions in North America)
Level II  (50)
Level III (182; descriptions include landforms, potential vegetation, land use,soils)
	Level IV (NA coverage not comprehensive)

· List Omernik Ecoregion levels I, II, III, and IV for the sample site

· Go to EPA’s website that explains and maps Omernik’s Ecoregions:

http://www.epa.gov/wed/pages/ecoregions.htm

· For levels I, II, III, and IV, select the links on the right and view appropriate .pdf maps or you may download the maps from the Resource Maps section at:

http://nctc.fws.gov/courses/csp/csp3200/resources/index.html

Note: You can zoom in and out in maps.

Record the Answers on your Data Sheet, Appendix 2

See also the description of the Level III Ecoregions for the continental U.S. in: 
Eco Level III Descriptions
For both Level III and Level IV Ecoregion descriptions for the sample site, see
EPA Region 3 Eco Description

[image: ]
Catchment Basin Characteristics

A sample site’s catchment is all the stream segments upstream of the sample site and all of the land that drains into those streams.  The topographic watershed boundary runs along ridges (“divides”).




From Rivers of Alabama
[image: ]Catchments are nested: here’s an example with sample sites denoted as red circles, and catchment areas as dashed lines-	
Important catchment attributes,

· Size (e.g., acres, hectares, square miles)

· Geomorphic properties (e.g., basin length and relief, drainage density and shape)

· Stream size of reaches (e.g., stream order)

· Land cover (e.g., geology, soils, vegetation, and land use in area & proportions)

Catchment basin attributes influence hydrology (water yield and pattern of floods) and sediment yields; both factors influence stream morphology and in-stream habitat.

Catchment basin size

Importance of catchment basin size include: 

· A factor behind geomorphological attributes as bankfull discharge, mean depth, width, and cross-sectional area (i.e., stream size and shape). 

· Drainage basin size often used to match study sites; for example, comparing similar-sized impaired sites to reference sites

· Assume similar sized stream sites have similar potential (e.g., fish species richness), other factors being equal

Catchment basin size can be determined by

· U.S. Geological Survey topographic maps (e.g., scale of 1:24,000 or 1 distance unit on map equals 24,000 distance units on ground)

· or more commonly, Geographic Information Systems (GIS) or viewers

Some basics,

Topographic map features:

· blue lines = streams
· solid lines = perennial streams
· dashed lines = intermittent streams
· brown lines = contour lines
· form “V”s where they intersect streams (“M”s above stream junctions); “V”s point upstream
· topographic high points marked by ring
· Headwater streams = streams with no tributaries

Note: It is important to realize that blue lines may not be an accurate representation of the spatial extent of perennial or intermittent streams.  Aquatic macroinvertebrate taxa that require perennial water have often been found “above the blue line” in Appalachia.

USGS Topographic Map
7.5 minute series, 1:24,000 scale
U
Ring-top of hill
Perennial stream
Non-forested area
Contour line
Forested area

Determining a topographic catchment basin
· locate all upstream tributaries that contribute flow through study site

· locate headwaters to determine top of drainage basin

· determine approximate location where surface run-off splits flow into and away from basin

· connect topographic high points

· draw drainage divide perpendicular to each contour line it crosses

· on flat areas, divide in half the area between streams


Example of a catchment basin for a sampling site on Virgil Creek

[image: TOPO]
· Determine the catchment basin size in square miles for the sample site on the un-named tributary of Little Antietam Creek.

Open the USGS The National Map Viewer:

http://nationalmap.gov/viewers.html


· Enter the sample site location coordinates: Latitude 39.6611˚ N and Longitude  -77.5463˚ W 
· Under “Overlays” > “Content”, select “Elevation Contours-Small Scale”; to enhance the blue flow lines, select the Hydrography (NHD)
· Zoom closer until the catchment basin is as large as you can get without going off the screen (e.g., scale of 1:72,224 or even 1:36,112); you can measure the area of a catchment that has part of the area off the screen but we won’t tackle this for the first attempt at area measurement
· Go to the “Advanced” tab, and select the “Measure Area” tool [image: ]
· Start at the sample site (click once) and begin to outline the topographic catchment basin; each time you must change directions, click once; when you have totally outlined the catchment boundaries, double click.  The catchment you outlined will fill in red and an area box will appear that includes area in square kilometers and in square miles.
· [image: ]You can zoom in closer (e.g., scale 1:36,112) to make sure your catchment boundaries followed the topographic divides; add more area to the catchment if needed; if your catchment is too large (you included area from adjacent topographic catchments), you can start over or measure the area of the adjacent catchments included in your catchment for the sample site, then subtract that area from your total catchment area





Record your Answer on your Data Sheet, Appendix 2

· 
Plug your catchment size (in square miles) into the regional curves listed below.  Either estimate from the graph or enter the sampling site watershed area into variable “DA” of the prediction equations.  Determine expected bankful discharge, cross-sectional area, width, and mean depth for the sample site.
[image: ]
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Record your Answers on your Data Sheet, Appendix 2






Steam size
	Stream size can be characterized in several ways, including by catchment size, average stream width, or by stream order (Strahler, Link Magnitude, D-Link, C-Link, and B-Link).  Stream size is important for determining biotic potential of streams.  Larger streams support more species of fish, for example.
	Position of streams in the larger watershed can be described by the link system.  Position also can be an important determiner of species richness.

Stream order:

	The oldest and most commonly used is Strahler stream order (Strahler 1957).

· headwater streams = 1st order

· 2 streams of order n form a stream of order n + 1

· 2 streams of different orders -- the stream they form does not change order (below confluence, stream order is the higher of the two parent streams)
[image: Strahler]











Stream Order: Link Magnitude (Shreve 1966)
· Link magnitude is the number of un-branched source streams upstream of a given segment in the drainage network.  
· [image: Link Magnitude]Think of it as a “finer-grained” stream size metric than stream order (used more in benthic invertebrate work

· The Link Magnitude number of a reach indicates how many tributaries are upstream of the reach.

Stream Order: D-Link
· Osborne and Wiley defined D-link as the link magnitude of the next downstream segment from the segment in question. 
· Emphasizes differences of small streams in upper watershed vs. small streams directing joining much larger streams.  Reason: similar sized streams could have different fish faunas depending upon where they link up to the stream system.
· “Adventitious streams” are small streams that join much larger streams (have small link number and large D-link number)
· First determine Link Magnitude for a drainage.  Then “shift up” the rating from the lower to the adjacent upper reaches (= D-Link).
[image: Link Magnitude]For example,
[image: ]




D-Link
Link Magnitude



Now, use more complicated drainage examples of Link magnitude and D-Link to illustrate D-Link application.
                
                    Link Magnitude                                                   D-Link
[image: ][image: ]








· Print out the catchment for the sample site in the USGS viewer or make hand sketches of the drainage.  Determine Strahler stream order, Link Magnitude, and D-Link for each stream reach.  What is the Strahler stream order, Link Magnitude, and D-Link values for the reach at the sample site?

Geomorphic Properties

Several geomorphic properties of catchments are listed and explained in Appendix 3 Geomorphic Properties Exercises.  Use the USGS The National Map Viewer to estimate these properties.  Use the “Measure Distance” and “Spot Elevation” tools and record your answers.

****************************************************************************************************
Now that you have completed the example exercise for the unnamed tributary of Little Antietam Creek, go through the same process to characterize our class field trip site (note: the sampling site is in Virginia).  Complete Appendix 2 Sample Site Identification, Regional Setting, Catchment and Reach Size Data Sheet and Appendix 3: Geomorphic Properties Exercises.  A blank set of Data Sheets, an aerial photo and topo map for “Sweet Run”, and a Physiographic Map of Virginia are located at:
http://nctc.fws.gov/courses/csp/csp3200/resources/index.html

The Field Site Location (Sweet Run) coordinates are:
Latitude 39.280474° N, Longitude -77.741648° W
Answer sheets will be provided on the first day of class.  We will be using this information as part of our analysis of the sampling site.

Appendix 1: Universal Transverse Mercator Geographic Coordinate System
The Universal Transverse Mercator (UTM) geographic coordinate system is a grid-based method of specifying locations on the surface of the Earth that is a practical application of a 2-dimensional Cartesian coordinate system. It is a horizontal position representation, i.e., it is used to identify locations on the earth independently of vertical position, but differs from the traditional method of latitude and longitude in several respects.
The UTM system divides the surface of Earth between 80°S and 84°N latitude into 60 zones, each 6° of longitude in width and centered over a meridian of longitude. Zone 1 is bounded by longitude 180° to 174° W and is centered on the 177th West meridian. Zone numbering increases in an easterly direction.
UTM Zones in the Northern and Western Hemisphere
[image: ]
Each of the 60 longitude zones in the UTM system is based on a transverse Mercator projection, which is capable of mapping a region of large north-south extent with a low amount of distortion.
An Earth location is defined as a point with x and y coordinates. In the UTM system, the terms easting and northing are geographic Cartesian coordinates for a point. A position is referenced by the UTM zone, and the easting and northing coordinate pair. The easting is the projected distance of the position eastward from the central meridian, while the northing is the projected distance of the point north from the equator (in the northern hemisphere). Eastings and northings are measured in meters. The point of origin of each UTM zone is the intersection of the equator and the zone's central meridian. In order to avoid dealing with negative numbers, the central meridian of each zone is given a "false easting" value of 500,000 meters. Thus, anything west of the central meridian will have an easting less than 500,000 meters. For example, UTM eastings range from 167,000 meters to 833,000 meters at the equator (these ranges narrow towards the poles). In the northern hemisphere, positions are measured northward from the equator, which has an initial "northing" value of 0 meters and a maximum "northing" value of approximately 9,328,000 meters at the 84th parallel — the maximum northern extent of the UTM zones. In the southern hemisphere, northings decrease as you go southward from the equator, which is given a "false northing" of 10,000,000 meters so that no point within the zone has a negative northing value.
As an example, the CN Tower is located at the geographic position 43°38′33.24″N, 79°23′13.7″W﻿ or ﻿43.6425667°N, 79.387139°W﻿ or 43.6425667, -79.387139﻿. This is in zone 17, and the grid position is 630084m east, 4833438m north. There are two points on the earth with these coordinates, one in the northern hemisphere and one in the southern. To define the position uniquely:
· Append a letter designator to the zone number, in this case "T" (see previous figure), thus "17T 630084 4833438".

Exercise-
Go to UTM converter http://www.dmap.co.uk/ll2tm.htm 
Enter Degrees, Minutes, and Seconds for the stream site location. Then choose grid area UTM (WGS84 datum) and the calculate button for determining the central meridian longitude. Finally, click convert to finish calculation. 
Your answer will be in easting and northing (x,y) coordinates (281507, 4393344); the grid reference is 18STJ 81507 93344. The first number of the grid reference number is the UTM zone. You would report your location as 18S 281507m E 4393344m N. 
Notice that the central meridian of zone 18 is 75o W longitude, because the eastern boundary is 72o W and the western boundary is 78o W. 
[image: ]UTM Zones in the Continental United States


Red star denotes approximate location of stream sampling site.



Appendix 2: Sample Site Identification, Regional Setting, Catchment and Reach Size Data Sheet

Investigator:  ________________________			Date:  ________________

Position Identification

Stream name/Study site name: ___________________________________________

Latitude _________________   Longitude ________________   Elevation _________

Grid Reference________________________________________________________

Zone     _________         UTM ____________________________________________   

County ___________________________   State _____________________________

USGS Topographic Map Name ___________________________________________

Water Body Coding

USGS catalog unit (HUC-8, sub-basin, EPA watershed)

	Division
	HUC
	Name
	Area

	Region
	
	
	

	Subregion
	
	
	

	Basin
	
	
	

	Subbasin
	
	
	

	Watershed
	
	
	

	Subwatershed
	
	
	



USEPA reach code _________________ __   Reach Length ____________________

Water Impairments: ____________________________________________________

Regional Setting   
Physiographic Province code/name: __ _____________________________________
Section code/name (or subprovince): _______________________________________
Region code/name: _____________________________________________________
District code/name: _____________________________________________________
Area code/name: _____  _________________________________________________
Hydrogeomorphic region: ______ __________________________________________

Ecoregions:  

Omernik Level I ___________________________________________________

Omernik Level II __ ________________________________________________

Omernik Level III __________________________________________________

Omernik Level IV __________________________________________________


Catchment (“Drainage”) Basin Characteristics

Catchment area ______________________________________________________	

Bankfull discharge		__________		 

Cross-sectional area	__________ 		 

Width			 _______		___	 

Mean depth 		___			_____	

*Reach type (e.g., Rosgen classification) _____________________________________

Reach size:

	*Average bankfull width ______	_____

	Strahler Stream Order ________	_____

	Link Magnitude ______________		

	D-Link ________________________	

* Stream classification and average bankfull width will be determined after field data collection.


Appendix 3: Geomorphic Properties Exercises

Once the catchment divide is drawn on a map and the area has been estimated, the geomorphic properties can be estimated, measured, or computed. Each of the geomorphic properties listed below includes a definition and explanation of its importance to catchment characterization.  The downstream boundary of the catchment is the sample site.

1.  Catchment length: Catchment length is estimated as the straight-line distance between the stream site and the drainage divide nearest to the source of the main stream [see “Main Channel Slope” description to find out how to delineate the main stream}. Catchment length is used to calculate drainage shape.

	ANSWER:  	___________________________________________________

2. Catchment relief: Catchment relief is the difference in elevation between the highest and lowest points in the catchment. It controls the stream gradient and therefore influences flood patterns and the amount of sediment that can be transported. Sediment load increases exponentially with catchment relief.

	ANSWER:  _____________________________________________________

3. Catchment relief ratio: The catchment relief ratio index is the catchment relief divided by the catchment length. It is useful when comparing catchments of different sizes because it standardizes the change in elevation over distance.

	ANSWER:  _____________________________________________________    

4. Catchment surface storage: The percentage of the catchment covered in lentic and impounded water bodies, including wetlands (optional), reflects the surface storage capacity of the catchment. Determine the catchment surface storage by measuring the area of each lake or impounded water body. Wetland areas will have to be estimated because the borders are not delineated on topographic maps. Add all water body and wetland areas and divide this sum by the drainage area.

	ANSWER:  ____________________________________________________


5. Drainage density: An index of the length of stream per unit area of catchment is calculated by dividing the drainage area by the total stream length [see page 2]. This ratio represents the amount of stream necessary to drain the catchment. High drainage density may indicate high water yield and sediment transport, high flood peaks, steep hills, low suitability for agriculture, and high difficulty of access.

	ANSWER:  __  __________________________________________________

6. Drainage shape: An index of drainage shape is computed as a unit less dimension of drainage area divided by the square of catchment length. It describes the elongation of the catchment and is useful for comparing catchments. If two catchments have the same area, the more elongated one will tend to have smaller flood peaks but longer lasting flood.

	ANSWER:  _____________________________________________________

7. Main channel slope: Main channel slope is an estimate of the typical rate of elevation change along the main channel that drains the catchment. This measurement is often related to peak flow magnitude and flood volume. Estimate the main channel slope by measuring the length of the main channel from the study site to the mapped source of the main stream. At each stream channel bifurcation, follow the fork with either the higher stream order number or the longer pathway to a stream source. Mark off 10% and 85% of the main channel length on the map. Estimate the elevation in meters at the 10% and 85% distance points, using the contour lines on the topographic map. Compute the main channel slope as follows:

Slope = (elevation at 85% length – elevation at 10% length) / 0.75 (main channel length).

	ANSWER:   ____________________________________________________

8. Total stream length: Total stream length is the sum of the lengths of all perennial streams within a catchment as shown on a topographic map. Determine the total stream length by measuring the length of each perennial stream section with a map measurer. Sum these individual stream lengths. The summed stream lengths determine the total amount of stream habitat in a catchment and the availability of sediment for transport.

	ANSWER:  _____________________________________________________

Appendix 4: Answers to Questions

Sample Site Identification, Regional Setting, Catchment and Reach Size Data Sheet

Position Identification

Stream name/Study site name:__unnamed tributary of Little Antietam Creek________

Latitude __39° 39' 39.9594"_N   Longitude _-77° 32' 46.68"_W   Elevation __~909’___

Grid Reference_____18STJ 8156493243____________________________________

Zone     _18S____         UTM _____18  281564m E   4393243m N_______________   

County __Washington_______________   State ___Maryland___________________

USGS Topographic Map Name _____Smithsburg_____________________________

Water Body Coding

USGS catalog unit (HUC-8, sub-basin, EPA watershed)

	Division
	HUC
	Name
	Area

	Region
	02
	Mid-Atlantic
	

	Subregion
	0207
	Potomac
	14,600 mi2

	Basin
	020700
	Potomac
	14,600 mi2

	Subbasin
	02070004
	Conococheague - Opequon
	2,278.9 mi2

	Watershed
	0207000410
	Antietam Creek
	290.9 mi2

	Subwatershed
	020700041004
	Little Antietam Creek
	24.7 mi2



USEPA reach code ___02070004002574 __   Reach Length ___1.184 miles_	__

Water Impairments_______None________________________________________

Regional Setting   
Physiographic Province code/name: __ 300000 Blue Ridge Province______________
Section code/name (or subprovince): __310000 Northern Blue Ridge Section_______
Region code/name:    312000 Catoctin-South Mountain Region___________________ 
District code/name: ____ None____________________________________________
Area code/name: _____  None____________________________________________
Hydrogeomorphic region: ______ Blue Ridge________________________________

Ecoregions:  

Omernik Level I ___Eastern Temperate Forests (8)_____________________

Omernik Level II __ Ozark, Ouachita-Appalachian Forests (8.4)____________

Omernik Level III __Blue Ridge (66)_________________________________

Omernik Level IV _  Northern Sedimentary and Metasedimentary Ridges (66b)_


Catchment Basin Characteristics

Catchment area ___2.426 square miles  or  6.284 square kilometers ____________

Bankfull discharge		70 cfs			 

Cross-sectional area	23 ft2			 

Width  			 	19 ft			

Mean depth   		1.2 ft			

*Reach type (e.g., Rosgen classification) __________________________________

Reach size:

	*Average bankfull width ____________	

	Strahler Stream Order ___	2___	_	

	Link Magnitude ______	6_________	

	D-Link _____		”Undefined”____	

* Stream classification and average bankfull width will be determined after field data collection.



Geomorphic Properties Exercises (answers)

Once the catchment divide is drawn on a map and the area has been estimated, the geomorphic properties can be estimated, measured, or computed. Each of the geomorphic properties listed below includes a definition and explanation of its importance to catchment characterization.  The downstream boundary of the catchment is the sample site.

1.  Catchment length: Catchment length is estimated as the straight-line distance between the stream site and the drainage divide nearest to the source of the main stream [see “Main Channel Slope” description to find out how to delineate the main stream}. Catchment length is used to calculate drainage shape.

	ANSWER:  	3.548 kilometers  -  11,641.448 feet   -  2.205 miles__________

2. Catchment relief: Catchment relief is the difference in elevation between the highest and lowest points in the catchment. It controls the stream gradient and therefore influences flood patterns and the amount of sediment that can be transported. Sediment load increases exponentially with catchment relief.

	ANSWER:  _______909’ - 1826’ =  917’______________________________

3. Catchment relief ratio: The catchment relief ratio index is the catchment relief divided by the catchment length. It is useful when comparing catchments of different sizes because it standardizes the change in elevation over distance.

	ANSWER:  ________917’  / 11,641’ =  0.078__________________________    

4. Catchment surface storage: The percentage of the catchment covered in lentic and impounded water bodies, including wetlands (optional), reflects the surface storage capacity of the catchment. Determine the catchment surface storage by measuring the area of each lake or impounded water body. Wetland areas will have to be estimated because the borders are not delineated on topographic maps. Add all water body and wetland areas and divide this sum by the drainage area.

	ANSWER:  _________.016 mi2  /  2.4mi2_=  .0067%____________________


5. Drainage density: An index of the length of stream per unit area of catchment is calculated by dividing the drainage area by the total stream length [see page 2]. This ratio represents the amount of stream necessary to drain the catchment. High drainage density may indicate high water yield and sediment transport, high flood peaks, steep hills, low suitability for agriculture, and high difficulty of access.

	ANSWER:  __  ______2.4 mi2 / 4.522 miles  = 0.531____________________

6. Drainage shape: An index of drainage shape is computed as a unit less dimension of drainage area divided by the square of catchment length. It describes the elongation of the catchment and is useful for comparing catchments. If two catchments have the same area, the more elongated one will tend to have smaller flood peaks but longer lasting flood.

	ANSWER:  _________2.4 mi2 / 4.8862  =  0.49________________________

7. Main channel slope: Main channel slope is an estimate of the typical rate of elevation change along the main channel that drains the catchment. This measurement is often related to peak flow magnitude and flood volume. Estimate the main channel slope by measuring the length of the main channel from the study site to the mapped source of the main stream. At each stream channel bifurcation, follow the fork with either the higher stream order number or the longer pathway to a stream source. Mark off 10% and 85% of the main channel length on the map. Estimate the elevation in meters at the 10% and 85% distance points, using the contour lines on the topographic map. Compute the main channel slope as follows:

Slope = (elevation at 85% length – elevation at 10% length) / 0.75 (main channel length).

	ANSWER:   _________442m – 286m / 0.75(3828.6m)  =  0.54, 5.4%_______

8. Total stream length: Total stream length is the sum of the lengths of all perennial streams within a catchment as shown on a topographic map. Determine the total stream length by measuring the length of each perennial stream section with a map measurer. Sum these individual stream lengths. The summed stream lengths determine the total amount of stream habitat in a catchment and the availability of sediment for transport.

	ANSWER:  __________4.522 mi or 7.2775km_________________________
	1	USFWS-NCTC
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